ANALOG
DEVICES

Evaluation Kit for 8-Channel,
200 kSPS, 12-Bit SAR ADC

EVAL-AD792]

FEATURES

Full-featured evaluation board for the AD7927 device

Evaluation control board (EVAL-CONTROL-BRD2) compatible

Standalone capability

On-board analog buffering and voltage reference

Various linking options

PC software for control and data analysis when used with the
EVAL-CONTROL-BRD2

GENERAL DESCRIPTION

This document describes the evaluation board used to test the
AD7927 ADC. The AD7927 is a high speed 12-bit successive
approximation ADC. This part operates from a single 2.7 V to
5V power supply and features throughput rates of up to 200 kSPS.
Refer to the AD7927 data sheet in conjunction with this document.

On-board components for this evaluation board include

e One AD780, which is a pin-programmable 2.5 V or 3 V
ultrahigh precision band gap reference

e One REF192 2.5V reference

e One AD712 dual op amp

e One AD713 quad op amp

Various link options are explained in Table 1.

Interfacing to the evaluation board is through a 96-way
connector that is compatible with the evaluation control board
(EVAL-CONTROL-BRD2), which is also available from Analog
Devices, Inc.

External sockets are provided for REFw, SCLK, DIN, DOUT,
and CS signals. In addition, the evaluation board includes two

bias-up circuits for bipolar input signals and eight sockets (Vix0
to Viv7) for the analog input channels.
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EVALUATION BOARD HARDWARE

LINK OPTIONS

There are 28 link options to be set before using the evaluation board. The functions of the options are outlined in Table 1.

Table 1. Link Functions

Link No. Function

LK1 to LK8 Connects the inputs of the AD713 to the input sockets (VinO to Vin7) or ties the AD713 inputs to AGND.
Position A: Each AD713 input is connected to the relevant input socket.
Position B: Each AD713 input is connected to AGND.

LK9 Selects the source of the 12V supply for the EVAL-AD7927.
Position A: The 12V supply is sourced from the EVAL-CONTROL-BRD?2 via the 96-way connector.
Position B: The 12V supply is sourced externally via the J2 connector.

LK10 Selects the source of the =12V supply for the EVAL-AD7927.
Position A: The —12 V supply is sourced from the EVAL-CONTROL-BRD?2 via the 96-way connector.
Position B: The —12V supply is sourced externally via the J2 connector.

LK11 Selects the source of the voltage applied to the REF pin of the AD7927 and to the bias-up circuits.
Position A: The REF192 supplies the 2.5 V reference to the AD7927.
Position B: The AD780 supplies the 2.5 V reference to the AD7927.

LK12 Selects the source of the data applied to the DIN pin of the AD7927.
Position A: The data is provided from the EVAL-CONTROL-BRD2.
Position B: The data is provided from an external source applied via the DIN SMB socket.

LK13 Selects the source of the Voo supply to the AD7927.
Position A: The supply voltage is provided from an external source via J5.
Position B: The supply voltage is provided from the EVAL-CONTROL-BRD?2 via the 96-way connector.

LK14 Selects the source of the CS signal for the AD7927.
Position A: The CS signal is generated by the EVAL-CONTROL-BRD?2 via the 96-way connector.
Position B: The CS signal is applied from an external source via the CS SMB socket.

LK15 Connects the data output pin, DOUT, of the AD7927 to the EVAL-CONTROL-BRD?2 or to an external SMB socket.
Position A: The DOUT pin is connected to the EVAL-CONTROL-BRD2.
Position B: The DOUT pin is connected to the external DOUT SMB socket.

LK16 Controls the program pin of the AD780 voltage reference.
When this link is inserted, the AD780 output voltage is set to 3.0 V.
When this link is removed, the AD780 voltage is set to 2.5 V.

LK17 Selects the source for the SCLK signal applied to the SCLK pin of the AD7927.
Position A: SCLK is applied from an external source via the SCLK SMB connector.
Position B: SCLK is an inverted signal from the EVAL-CONTROL-BRD2.

Position C: SCLK is sourced directly from the EVAL-CONTROL-BRD2.

LK18 Selects the source for the Vorive voltage.

Position A: Vorive is connected to AVpp of the AD7927.

Position B: Vorive is provided from the EVAL-CONTROL-BRD2 via the 96-way connector.
Position C: Vorive is provided from an external source via the external J4 connector.

LK19to LK28 | Addsa 51 Q termination resistor to AGND at the Vin0 to Vin3 input sockets.
When a 51 Q termination is required, these links should be inserted.
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OPERATING THE EVALUATION BOARD

The evaluation board can be used either as a standalone board
or it can be operated in conjunction with the EVAL-CONTROL-
BRD2. When operated with the EVAL-CONTROL-BRD?2, all
supplies and control signals to operate the AD7927 are provided
by the EVAL-CONTROL-BRD?2. Software to communicate
between the control board and the AD7927 is provided with the
evaluation board kit. The EVAL-CONTROL-BRD?2 operates
with all Analog Devices evaluation boards with model numbers
ending in the letters CB.

Power Supplies

When using this evaluation board with the EVAL-CONTROL-
BRD?2, all supplies are provided from the control board through
the 96-way connector.

When using the board as a standalone unit, external supplies
are required. This evaluation board has seven power supply
inputs: EXT_Vpp, AGND, +12 'V, —12 V, AGND, Vprive, and
DGND. If the evaluation board is used in standalone mode, a

Table 2. Initial Link Positions

2.7 V to 5 V supply must be connected to the EXT_Vpp input.
The +12 V and —-12 V supplies are required for the op amps.
The Vorwve input can be connected to a supply from 2.7 Vto 5V,
allowing the evaluation board to be connected to both 3 V and
5V systems. The supplies are decoupled to the ground plane
with 10 pF tantalum and 0.1 pF multilayer ceramic capacitors
at the point to the board. The supply pins of all the op amps, the
reference, and the AVop pins of the AD7927 are decoupled with
10 pF tantalum and 0.1 pF ceramic capacitors.

INITIAL SETUP CONDITIONS

Before applying power or signals to the evaluation board, care
should be taken to ensure that all link positions are as per the
required operating mode. Failure to do this may result in
damage to the evaluation board.

Table 2 outlines the default positions of all links when the board is
shipped. The links are set so that all power supplies and control
signals are supplied by the EVAL-CONTROL-BRD2.

Link No. Position | Function

LK1 A Input of AD713 is connected to the Vin0 SMB socket.

LK2 to LK8 B AD713 inputs are connected to GND.

LK9 A The +12V supply is generated by EVAL-CONTROL-BRD2.

LK10 A The —12V supply is generated by EVAL-CONTROL-BRD2.

LK11 B The AD780 supplies the 2.5V reference to the AD7927.

LK12 A Data applied to the DIN pin of the AD7927 is generated by EVAL-CONTROL-BRD2.
LK13 B Voo is supplied from EVAL-CONTROL-BRD2.

LK14 A The CS signal is generated by EVAL-CONTROL-BRD2.

LK15 A The DOUT pin is connected to EVAL-CONTROL-BRD2.

LK16 ouT The AD780 voltage is set to 2.5 V.

LK17 C The SCLK signal is sourced directly from EVAL-CONTROL-BRD2.
LK18 B Vorive is generated by EVAL-CONTROL-BRD2.

LK19to LK28 | OUT A 51 Q termination on the inputs is not added.
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INTERFACING THE EVALUATION BOARD

Interfacing the evaluation board to the EVAL-CONTROL-BRD2 or
another system is accomplished via a 96-way connector, J1. Plug
the 96-way connector of the evaluation board directly into the
96-way connector of the EVAL-CONTROL-BRD2.

The 96-way connector is powered from a 12 V ac transformer.
Suitable transformers, including the following, are available from
Analog Devices as accessories:

e EVAL-110VAC-US: for use in the U.S. or Japan
e EVAL-220VAC-UK: for use in the UK.
e EVAL-220VAC-EU: for use in Europe

Other suppliers also offer compatible transformers, including
Digi-Key Corporation (U.S.) and Campbell Collins, Ltd. (UK.).

Connection between the EVAL-CONTROL-BRD2 and the
parallel port of a PC is via a standard Centronics, Inc., printer
port cable, which is provided as part of the EVAL-CONTROL-
BRD2 package. Refer to the manual that accompanies this package
for more details.

Figure 2 shows the pinout for the 96-way connector, and Table 3
and Table 4 list the pin descriptions and designators.

1 8 16 24 32

O0000000000000000000000000000000
O0000000000000000000000000000000
O0000000000000000000000000000000

1 8 16 24 32

O w>

06199-002

Figure 2. Pin Configuration for the 96-Way Connector, J1

Table 4. 96-Way Connector Pin Functions'

Table 3.
Pin Description
DR Data Receive. Serial data from the device is provided at this

output. Sixteen bits of data are provided with a leading
zero, three channel address bits, followed by twelve bits of
conversion data provided MSB first.

DT Data Transmit. Serial data from the DSP is provided at
this pin. Twelve bits of data are provided, which are
provided MSB first.

SCLK | Serial Clock Zero. This continuous clock is connected to
the SCLK pin of the AD7927 via LK17 to obtain serial
data from the device.

TFSO Transmit Frame Sync Zero.

RFSO | Receive Frame Sync Zero. Both the TRSO and RFS0 inputs
are connected to the AD7927 CS pin to initiate
conversions and frame the serial data transfer.

DGND | Digital Ground. These lines are connected to the digital
ground plane of the evaluation board and allow you to
provide the digital supply via the connector and the
other digital signals.

AGND | Analog Ground. These lines are connected to the
analog ground plane of the evaluation board.

AVop Analog +5V Supply. These lines are connected to the
AVop supply line of the evaluation board via LK13.
+12V | +12V Supply. This line is connected to the +12V supply
line of the evaluation board via LK9.

—12V | =12V Supply. This line is connected to the —12V supply
line of the evaluation board via LK10.

Pin No. Row A Row B Row C
1

2

3

4 DGND DGND DGND
5 DTO DRO

6 TFSO RFSO
7 SCLKO SCLKO
8

9

10

11

12 DGND DGND DGND
13

14

15

16 DGND DGND DGND
17

18

19

20 DGND DGND DGND
21 AGND AGND AGND
22 AGND AGND AGND
23 AGND AGND AGND
24 AGND AGND AGND
25 AGND AGND AGND
26 AGND AGND AGND
27 AGND

28 AGND

29 AGND AGND AGND
30 -12V AGND +12V
31

32 AVpp AVpp AVpp

' The unused pins of the 96-way connector are not shown.
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SOCKETS

There are 20 input/output sockets relevant to the operation of the AD7927 with this evaluation board. The functions of these sockets are
outlined in Table 5.

Table 5. Socket Functions

Socket Function

J1 96-way connector for serial interface and power supply connections.

J2 External +12V, —12V, and AGND power connector.

J3 External Vorve connector.

J4 Subminiature BNC socket for bipolar input signal to Bias-Up Circuit 0.

J5 External Voo and AGND power connector.

J6 Subminiature BNC socket for output from Bias-Up Circuit 0. Unipolar signal.
J7 Subminiature BNC socket for bipolar input signal to Bias-Up Circuit 1.

J8 Subminiature BNC socket for output from Bias-Up Circuit 1. Unipolar signal.
VinO to Vin7 Subminiature BNC sockets for analog input Channels 0 to 7.

REFn Subminiature BNC socket for REFw voltage.

SCLK Subminiature BNC socket for external SCLK.

cs Subminiature BNC socket for external CS.

DIN Subminiature BNC socket for external DIN.

DOUT Subminiature BNC socket for DOUT signal.

Rev. 0| Page 6 of 16




EVAL-AD7927

EVALUATION BOARD SOFTWARE

STATUS BOXES
I

mADTQZT Evaluation Software AQIE]
MENU BAR — File Printer Port  Control Register  Sequence]l  Help
Unused Configuration: 2048 Data Samples Uploaded
: Part:AD7927 2048 Data Samples Uploaded
conTROL | Cont Samp Wnused Program:ad7927 PRG 2048 Data Samples Uploaded
BUTTONS Stop Samp Unuse |Bits:12 2048 D ata Samples Uploaded
. Code: Binary 2048 Data Samples Uploaded Max:  4057.0000
Resat Quit 2048 D ata Samples Uploaded Min. 18,0000
]Inlegels Vl
V¥ \ertical Grid
DIGITAL ¥ Horizontal Grid
STORAGE I Hold Zoom
osciLL0SCoPE I Tick Data Points
I~ Zoom Handles
DC Bins  Signal Bins
zlisi# ={f+ #
¥ Hams [~ 4wvag
FAST 1 :
FOURIER v B-H Windowing
TRANSFORM
(FFT) SNR: 70.049dB
THD: -77.588dB
FREQ: 10.06KHz

Figure 3. Main Dialog Box

INSTALLING THE SOFTWARE
The EVAL-AD7927 kit includes a CD-ROM.

When the CD is inserted into the PC, an installation program
automatically begins. This program installs the evaluation software.

THE MAIN DIALOG BOX

The software that controls the EVAL-CONTROL-BRD2 and
therefore the AD7927 evaluation board consists of three dialog
boxes. The main dialog box—the AD7927 Evaluation Software
dialog box, shown in Figure 3, allows you to read a predetermined
number of samples from the evaluation board and display the
samples in both the time and frequency domain. This dialog
box can be divided into three sections.

The top section of the dialog box contains the control buttons,
the menu bar, and the status boxes.

Control Buttons
Use the control buttons to sample data (Sample), reset the

board (Reset), and retrieve information about the software.

Click Reset to cause the EVAL-CONTROL-BRD2 to perform a

reset. During a reset, the power supply to the evaluation board is
turned off, and the program in the DSP memory is lost. If required,
set up the board again to download another program. Click Quit to

exit the software. Note, however, that this will not terminate the
program running on the EVAL-CONTROL-BRD2.

Menu Bar

The menu bar consists of the File, Printer Port, Control
Register, Sequence, and Help drop-down menus.

The File drop-down menu offers the following selections:

e Setup Menu. Select this option to display the Setup Menu
dialog box, as shown in Figure 5.

e Load Raw Data. Select this option to load data saved by
the software during a previous session.

e  Save Raw Data. Select this option to save the current set of
sample data points. The data can be reloaded to the evaluation
software later or can be used by other programs for analysis.

e  Save Binary Data. Select this option to save the current set
of sample data points. The data is saved in binary format as a
text file. This method can be useful for examining code flicker
and identifying stuck bits, that is, bits that are not changing.

e  Save FFT Data. Select this option to save the current set
of FFT data points. FFT data cannot be reloaded into the
EVAL-CONTROL BRD2 software, but can be loaded into
other software packages for further analysis.

e  Exit. Quits the program.
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The Printer Port drop-down menu allows you to select the printer
port used to communicate with the EVAL-CONTROL BRD2.

e LPT1. This option selects 0x378 as the printer port base
address. This is the default option.

e LPT2. This option selects 0x278 as the printer port base
address.

e  PRN. This option selects 0x3BC as the printer port base
address.

Set up the operating conditions for the device using the Control
Register drop-down menu. After you select the conditions, a
12-bit word is sent to the AD7927 control register on the next
serial transfer.

The Sequence menu is inactive in this version of software.
The Help drop-down menu provides information about the
current version of software for the evaluation board.

Status Boxes

The status boxes display the setup of the evaluation board, the
number of samples taken, and any messages generated.
Oscilloscope

The middle section of the main dialog box is a digital storage
oscilloscope (DSO). It can display samples uploaded from the
EVAL-CONTROL-BRD2. Samples can be displayed as integer

values or as voltages. After samples are displayed, click any
point in the graph to display the sample number and value of
that point. Along the axis of the graph are sizing handles that
allow you to zoom in for a closer look of a sample, if required.
When another set of samples is taken, the graph attempts to
display all values collected unless the Hold Zoom check box is
selected. If Hold Zoom is selected, the graph retains the same
axis settings as the previous set of data samples. Additional
check boxes are provided so that you can control the vertical
and horizontal grids and the data points.

Fast Fourier Transform/Histogram

The lower section of the main dialog box can display a fast
Fourier transform (FFT) of the data or a histogram, which
shows the number of occurrences of each code readback. The
FFT (default option) is typically used for assessing an ADC’s
performance in the frequency domain, whereas the histogram is
used to assess the ADC’s performance with dc signals. The option
displayed can be switched by clicking FFT Mode/Histogram
Mode at the upper right of the dialog box. Figure 4 shows the
main dialog box when the Histogram Mode option is selected.

STATUS BOXES

nADTQZT Evaluation Software =10l x|
MENU BAR — File Printer Port Control Register Scquc Help
& Unused Configuration: 2048 Data Samples Uploaded
= Part:AD7927 2048 Data Samples Uploaded Histogram Mode
CONTROL ContSamp | Urieed | Iprogram:ad7927.PRG 2048 Data Samples Uploaded
BUTTONS Stop SamE Untreed Bits:12 2048 Data Samples Uploaded
- Code: Binary 2048 Data Samples Uploaded M a: 0.0000
L Reset Quit 2048 Data Samples Uploaded Min: 0.0000
4000 - ' ! : ! : (§ ! L
3500 -] | ! :_ Integers -
3000 - == = | T ¥ Vettical Grid
DIGITAL 2500 7 | I = ¥ Horizontal Grid
STORAGE 2000 - ! | = " HoldZoom
OSCILLOSES 1500 - | - = I Tick Data Points
1000 -/ | | = [~ Zoom Handles
500 - - =
0 - v T T T T T
0 500 1000 1500 2000
Samples: 2048
Max Code: 0
Min Code: 0
Spread: 1
s g0%
| : -
HISTOGRAM 0000000000000000 2048

Figure 4. Main Dialog Box, Histogram Mode
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SETUP MENU

The Setup Menu, shown in Figure 5, allows you to load the
required configuration file for the evaluation board. When the
configuration file is loaded, the software acquires detailed infor-
mation about the evaluation board and the ADC connected to
EVAL-CONTROL-BRD2. This includes information such as
the number of bits, maximum sampling rate, type of output coding,
maximum analog input, and power supply requirements.

The configuration file also indicates to the software the name of
the DSP program file to download to the EVAL-CONTROL-
BRD2. The Setup Menu allows you to choose the sampling
frequency and the number of samples.

CHECKING THE EVAL-CONTROL-BRD2

The EVAL-CONTROL-BRD2 and the evaluation board should
be connected together as described in the Interfacing the
Evaluation Board section.

At this stage, the red LED on the EVAL-CONTROL-BRD2
should be flashing. This indicates that the EVAL-CONTROL-
BRD?2 is functional and ready to receive instructions.

Note that the software should be installed before the printer
port cable is connected between the EVAL-CONTROL-BRD2
and the PC. This ensures that the printer port has been
initialized correctly.

x

USING THE SOFTWARE
After the hardware and software is set up
1. From the File menu, select Setup Menu.

A setup form displays. A list box on the Setup Menu lists
the available configuration files. The configuration files are
text-based files containing information about the ADC to
be tested (AD7927.cfg).

2. Select the relevant configuration file and click Load.

The EVAL-CONTROL-BRD?2 is reset, and the DSP
program is downloaded. After the download is complete, the
power supply settings indicated in the configuration file are
set and you may hear some of the relays clicking. The
drop-down list boxes, Select No. Of Samples and Select
Sample Frequency, are set to the default values specified in
the configuration file. Note that you can change these
settings at any point.

3. After all the settings are set, click Close to return to the
main dialog box.

Default Conditions

The EVAL-AD7927 is configured to convert on Channel 0 in
normal mode with straight binary output coding and a 0 to REFix
input range. If no changes are made to the control register via

the Control Register drop-down menu on the main dialog box,
clicking Sample yields conversion results from Channel 0.

Select a Configuration File Select No. Of Samples Input Max [V)
AD7927.cfg | 256 ~| 500
Select Sample Frequency Input Min [v]
| 100000 ~|  Jooo

Other Sample Frequency

Supply Settings ]1 AL

+12V AVDD DVDD AVDD DVDD BUS |

—_—

Hz Load |

Cancel |

06199-005

Figure 5. Setup Menu Dialog Box
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Taking Samples

To instruct the EVAL-CONTROL BRD2 to obtain the required
number of samples at the required frequency, follow these steps
using the main dialog box, shown in Figure 3:

1. Click Sample.
Select a sampling frequency up to the rate of 200 kSPS.

Samples are uploaded and displayed. An FFT and
histogram are also calculated and displayed.

2. Click Cont Sample to continue taking samples.

To stop sampling, click Cont Sample again. Note that
while the software is continuously sampling data, the other
control buttons are disabled.

3. Click Exit to stop the process.
Software Configuration Files

Software configuration files provide the EVAL-CONTROL-
BRD2 software with information on how the software and
hardware should perform. These files contain information, such
as the name of the DSP program to download, the default and
maximum sampling frequencies, the number of samples to take,
and the power supply settings to use.

What follows is a typical software configuration file (*.cfg).

[EVAL-CONTROL BOARD]
partname:AD7927
programname:ad7927.PRG

samplefrequency:100000
maxsamplefrequency:200000
samples:2048

+/-15V:on

dvdd:5:0on

avdd:5:0n

bus:on

;options 2scomp, binary
dataformat:binary
numberofbits:12
inputVmax:2.5
inputVmin:0
[endofconfig]

Sequencer Modes: FFT Mode and Histogram Mode
FFT Mode

To operate the EVAL-AD7927 in FFT mode with the sequence
and shadow bits set to 11 in the Control Register drop-down
menu, follow these steps:

1.  Select the 11 combination from the Shadow/Seq bits in the
Control Register drop-down menu.

2. Select the final channel in the sequence.
3. After the control register configuration is set, click Sample.

When the evaluation board is finished taking samples on the
selected channels in the sequence, the resulting FFTs are displayed
in the lower section of the main dialog box. SNR:, THD:, and
FREQ: show results that correspond to the final channel in the
programmed sequence.

If individual SNR, THD, and frequency results are required from
each individual channel, operate the device in normal mode with
the sequence and shadow (Shadow/Seq) bits set to 00 and select
the individual channel in the Control Register drop-down menu.

Histogram Mode

When operating the evaluation board in histogram mode with
the sequence and shadow bits set to 11 in the Control Register
drop-down menu, follow these steps:

1. Select the 11 combination for the Shadow/Seq bits in the
Control Register drop-down menu.

2. Select the final channel in the sequence.
3. After the control register configuration is set, select Sample.

When the evaluation board is finished taking samples on the
selected channels in the sequence, the resulting histogram displays
in the lower portion of the main dialog box. The histogram cor-
responds to the first channel in the programmed sequence. Max
Code:, Min Code:, Spread:, Std Dev:, and Mean: show results
that correspond to the first channel in the programmed sequence.

If you want the codes, such as the maximum code and the mini-
mum code, to correspond to a particular channel, operate the ADC
in normal mode with the sequence and shadow (Shadow/Seq) bits
set to 00 and select the individual channel in the Control Register
drop-down menu.
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EVALUATION BOARD SCHEMATICS AND ARTWORK
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Figure 7. Schematic 2
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Figure 9. Solder Side Artwork
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Figure 10. Component Placement Drawing
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ORDERING INFORMATION

BILL OF MATERIALS

Table 6. Components Listing

Qty | Reference Designator Part Type/Description PCB Decal Supplier No.'
1 U1 8-channel, 200 kSPS, 12-bit TSSOP-16 Analog Devices AD7927
ADC with sequencer
2 u2,U3 Quad precision, low cost, SOIC16NB Analog Devices AD713
high speed BiFET op amps
3 U4, U5, U8 Dual precision, low cost, SOIC8NB Analog Devices AD712
high speed BiFET op amps
1 ué Tiny logic high speed inverter SOT23-5 FEC 685-914
1 u7 2.5V/3.0V ultrahigh precision SOIC8NB Analog Devices AD780
band gap voltage reference
1 U9 Precision micropower, low dropout, SOIC8NB Analog Devices REF192
low voltage reference
10 R1toR10 51 Q resistors 805 FEC 321-7905
10 R11 to R20 1 kQ resistors 805 FEC911-859
2 R21, R22 3 kQ resistors 805 FEC321-8119
21 C1toC12,C14to C16, 0.1 uF capacitors 805 FEC 499-687
C19, C21,C23,C25,
C26,C28
20 C17,C18,C20, C22,C24, 10 YF tantalum capacitors CAP\TAJ_B FEC 197-427
C27,C29,C35t0 C47
1 c13 1 WF capacitor 805 FEC 317-640
4 C30to C33 68 pF capacitors 603 FEC 722-066
1 C34 10 nF capacitor 805 FEC 499-225
2 D1,D2 Schottky diode D035 Vishay SD103C
17 DIN, CS, DOUT, J4, J6, J7, J8, REFIN, 50 Q gold-plated PCB SMB jacks SMB FEC 310-682
SCLK, VINO to VIN7
1 1 CON\41612\96 DIN41612-96 FEC 104-986
J2 3-pin power connector CON\POWER3 FEC 151-786
2 J3,)5 2-pin power connectors CON\POWER FEC 151-785
15 LK1 to LK15 4-pin headers (2 x 2) Headers FEC511-791
1 LK16 Jumper SIP-2P FEC 511-705
10 LK19 to LK28 Jumpers SIP-2P FEC 511-705
2 LK17,LK18 6-pin headers (2 x 3) Headers FEC 511-780
14 LK1 to LK14 Shorting links FEC 528-456
5 T1toT5 Testpoints Testpoints FEC 240-333
X1 Clamp-SOIC-TSSOP Clamp
4 Each corner Stick-on feet 3M FEC 651-813

' FEC = Farnell Electronic Components®.
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ESD CAUTION

ORDERING GUIDE
Model Description
EVAL-AD7927CB AD7927 Evaluation Board

©2007 Analog Devices, Inc. All rights reserved. Trademarks and
registered trademarks are the property of their respective owners.

EB06199-0-1/07(0)

A
Arad

ESD (electrostatic discharge) sensitive device.
Charged devices and circuit boards can discharge
without detection. Although this product features
patented or proprietary protection circuitry, damage
may occur on devices subjected to high energy ESD.
Therefore, proper ESD precautions should be taken to
avoid performance degradation or loss of functionality.

ANALOG
DEVICES
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